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Welcome 

Welcome to Your Quick Expression Web Tutorial: California Water Animals! We hope you find this 
tutorial a valuable learning experience as you develop your Web design skills.  
The goal of this tutorial is to teach you how to use Microsoft® Expression Web to build a creative, 
dynamic Web site from scratch with the tools that professional Web designers use.  

 
Tips for Students  
 

 This tutorial is divided into 6 modules.  

 Each module will take between 30-60 minutes to complete.  

 Read each module thoroughly before beginning to use the software.  

 Your action steps are numbered. Background information is not numbered.  

 Keep track of your progress by checking off each module as you complete it.  

 Save your work often.  
 

Notes to instructors  
A tutorial that creates ASPX pages with layers, Cascading Style Sheets (CSS), and interactive buttons and 
a calendar. All of the image and text resources are included with this tutorial in the folder 
 
Note 1: ASPX pages require a server with IIS if the site is to be posted on the Internet. Projects will 
render correctly within the Expression Web development environment.  
 
Note 2: If student documents are stored remotely on a network away from the computer they are 
working on, the path name to master pages and any other links MUST be the complete path name. 
 
This tutorial can be used as a teacher-guided activity or as an independent learner activity. The 
directions are complete enough for students to proceed on their own on their own pace. 
  
A variety of other tutorials for Expression Web and Expression Design and a complete semester 
curriculum unit is available from the Pre-Collegiate Faculty Connection Web site at 
www.microsoft.com/facultyconnection/precollegiate.  
 
The tutorials and curriculum materials were designed by teachers and tested by teachers and students 
in middle and high school classrooms.  
 
The curriculum resources can be customized and integrated with a variety of curricular areas; they are 
particularly well-suited for collaborative team projects. Projects can be focused toward meeting the 
national standards of a wide variety of curricular areas such as technology, math, science, social studies, 
geography, etc.  
 
If you are curious about how to get Expression Web software for your school or non-profit organization, 
please go to www.msdnaa.net. With an MSDN Academic Alliance for High School subscription you can 
install Expression Web on every instructional computer in your school and allow students to install the 
software on their personal computer for only US $299 total. 

  

www.microsoft.com/facultyconnection/precollegiate
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Getting Started 



 Module 1  
 

Let’s get started! 

Here’s a sneak preview of the site we’ll be making in this lesson.  
 

 
 
 
In this tutorial, you will explore and learn basic Web design practices, including how to create a new 
Web site, ASPX pages and styles with Cascading Style Sheets (CSS). Using these techniques will 
make formatting the look of your Web pages easy and fun.  
There are many ways to create a Web site. Some, like static HTML pages, are relatively simple; 
others are more complex. For example, you can use Expression Web to create ASP.NET sites and to 
work with XML and RSS. (See the Glossary at the end of this tutorial for a description of these and 
many other terms.)  
 
The site you are creating is an ASP.NET site—the files are named with an .aspx extension to identify 
them from static HTML pages. ASP.NET enables you to create Web features like forms and 
interactive pages. Although you will be building a relatively simple site in this lesson, the more 
advanced techniques you learn in this introduction also apply to more complex site development.  



Launching Expression Web  
If this is the first Web site you’ve created with a WYSIWYG (What You See Is What You Get) Web 
design program like Expression Web, this first module may take a bit longer than you expect. But 
once you get familiar with the work environment of Expression Web, you will find it quick and easy 
to produce cool Web pages in no time at all. So, take your time, read the directions thoroughly 
before you begin working with the program, relax, and have fun!  
 
When you first launch the program, you will find a number of task panes, toolbars, and dialogs with 
a wide range of features. You can customize the workspace by docking and undocking toolbars, 
opening and closing task panes, and changing preferences settings.  
 
Note: By default Expression Web opens the most recently opened Web site and lists the contents of 
that project in the workspace window. When you create a new site or open another existing site, 
Expression Web will replace the contents of the window.  
 
You will find the various toolbars, including dedicated toolbars for working with images and CSS, 
under the View menu when you choose Toolbars. You can open and close task panes by selecting 
them from the Task Panes menu.  
 
When you are more experienced with Expression Web you might want to change preferences. I 
don’t recommend you do that now, but when you do just select Tools | Application Options or 
select Tools | Page Editor Options.  
 
You can also can also specify preferences for a particular site by choosing Site | Site Settings.  
 
It will be useful to become familiar with the Expression Web workspace layout. The following 
picture identifies a few of the toolbars and task panes you will be using in this tutorial.  
 
 
 
Power User Tip: To reset the workspace to the default arrangement, on the Task Panes menu,  
click Reset Workspace Layout.  



The Microsoft Expression Web Workspace 

 
 
 
1. Common Toolbar  
2. Folder List  
3. File Tabs  
4. Toolbox  
5. Style and Layer Task Panes  
6. View Tabs ** for this tutorial keep this set to Design  
7. Tag and CSS Property Task Panes  
8. Breadcrumb Trail  
 
Power User Tip: You can see the code behind your Web page design by selecting Code in the View 
Tab at the bottom of the workspace. Expression Web generates this code as you modify your 
design. Unless you are familiar with the html language, do not modify this code.  
The Split view option shows both the design and code of the page. As you make changes to the 
design, the code is automatically modified to reflect the changes made. 



Starting a New Site  
Note to instructor: The network used in a classroom environment may require different directions 
for saving projects. Modify steps 1 – 9 as appropriate for you system. 
  
Before you begin identify or create a folder location where you will save your new site folder. Copy 
the folder named Resource Files (found in the same folder as this tutorial) into your designated 
storage folder so you can easily find the images and text documents needed to complete this 
tutorial.  
 
Because you are building a multi-page site, you will start by creating a new Web site in Expression 
Web to help manage all of the pages.  
 

1. Open Expression Web and take note of the toolbars and task panels labeled on the image 
above.  
 

2. Choose File | New | Web site  
 

3. In the New dialog, choose the Web site tab at the top of the dialog window. 
  

4. Choose General and then choose Empty Web site.  
Do not hit OK yet. 

 
You selected the Empty Web site option because you plan to create a new site with more than one 
page. When you select this option, Expression Web creates a new blank folder where all of the files 
and folders of your Web site are saved.  
 
When you first create a site like this you have the opportunity to name it. If you do not give it a 
name, Expression Web will assign one for you, such as Web 1, Web 2, etc. If you are working on 
multiple sites, it is easier to keep track of them if you choose a name that has meaning to you. By 
default Expression Web offers to save your site at …\UserName\Documents\ and to name it My 
Web Sites (Windows Vista) or mysite (Windows XP.) It might be more convenient to save your site 
outside of your Documents folder.  
 

5. Use the Browse button to locate and select the folder into which you want the site folder 
and these web documents to be saved.  

  



In the following picture, you will see a folder named EW Web site where all of the folders and 
files related to this project will be saved. In a classroom setting the instructor will give you 
specific directions concerning the location you should create or select. 
  

 
 
 
 
 

6. With the correct folder selected, click Open.  



 
7. An automatically generated name may appear at the end of the path at the bottom of the 

New Site dialog. If necessary delete that name and enter a new name to replace it.  
 
Name this site "CaliforniaWaterAnimals_LastName." (Replace the words ―LastName with your last 
name.)  
 
 
 

 
 
This will create a root folder for your site and EW will store all of your files in this folder. This helps 
ensure that your links and images will work properly when you publish them to a Web server.  
 

8. Now Click OK.  



Creating a New Page 

 
1. To create a new ASPX Web page document, choose File | New | Page.  

 
2. Specify the type of page you want to create. For this example, you will be working with an 

ASPX file. Click OK.  
 

3. Before you do anything else, it is good to get into the habit of saving your page—File | Save. 
If this is the main page of your site, you will want to name it index.aspx or default.aspx, 
depending on how your server is set (check with your hosting service or system 
administrator.) The default location for saving this file is the folder created when you made 
this new site— 

CaliforniaWaterAnimals_LastName. Click Save.  
 
 

 
 
 
Power User Tip: Name your remaining files and folders in your site anything you like,  
but do not use spaces or special characters such as *, %, $, or / because many Web servers have 
strict naming conventions and the file name affects your links. 
 



4. Open the Page Properties dialog by right clicking anywhere within the body or workspace 
of the page. Changes made in this dialog will apply to the entire page. It’s a good habit to set 
all of the Page Properties settings as soon as possible. 

 
5. Add a page Title. This text appears in the very top of a browser window, and it is also the 

text saved in the bookmarks list when someone bookmarks your page. Add a Page 
description and a few Keywords that can be used by search engines. See the sample below.  

 
Do not click OK yet.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

6. Under the Formatting tab in this same dialog, you can specify text, background, and link 
colors for your page. For this exercise, leave the background and text colors set to white and 
black, but change the link colors as follows: Hyperlink | Maroon, Visited Hyperlink | Silver, 
Active Hyperlink | Yellow, and Hovered Hyperlink | Yellow. You will save these tag settings 
later so you can use them throughout the entire site.  
Do not click OK yet.  

 

 
 
  



7. Under the Advanced tab, you can set the margins. We recommend setting all of the margins 
to 0 to get rid of the default space that creates a small margin around the edge of the page 
when displayed in a browser.  

 

 
 

8. Click OK to close the Page Properties dialog.  
 
Power User Tip: Microsoft® Expression® Web maintains a list of the last 30 actions and lets you 
undo each in sequence. Similarly, you can redo any of the last 30 actions you have undone.  

 To undo the last action you performed, click Undo (or just press CTRL + Z). If you click Undo 
again, Expression Web will undo the action you performed before that, and so on.  
 

 To see a list of the most recent actions that you can undo, click the arrow next to Undo, and 
then select the action or actions that you want to undo.  

 

 To redo the last action you undid, click Redo (or just press CTRL + Y).  
 

 To see a list of the most recent undone actions that you can redo, click the arrow next to 
Redo , and then select the undone action or actions that you want to redo.  



A bit more information about ASP.NET  
Now that you’ve created your first page with Microsoft® Expression® Web, it will be helpful to 
deepen your understand of ASP.NET.  
ASP.NET is the latest version of Microsoft's Active Server Pages technology (ASP). It is a powerful 
tool for creating dynamic and interactive Web pages. Web sites that pull up-to-date information 
from databases, (such as e-commerce sites or others with forms that request user information,) are 
described as dynamic or interactive. The names of Web page files created with ASP.NET technology 
have an .aspx extension. An example of a site built upon ASP.NET is Microsoft’s Live Search  
 
http://local.live.com/default.aspx?wip=2&v=2&style=r&rtp=~&&msnurl=home.aspx?&redirect=fals
e&msnculture=en-US  
 
To learn more about ASP.NET, visit http://asp.net/get-started/ 
  

http://local.live.com/default.aspx?wip=2&v=2&style=r&rtp=~&&msnurl=home.aspx?&redirect=false&msnculture=en-US%20
http://local.live.com/default.aspx?wip=2&v=2&style=r&rtp=~&&msnurl=home.aspx?&redirect=false&msnculture=en-US%20
visit%20http:/asp.net/get-started/


Creating Page Layouts with Layers  
Now that you have set up your site and your first page, you are ready to start adding content. Let’s 
begin by creating the layout for this page using the Layers option. Layers are containers that hold 
elements on your Web site, but are invisible when the page is viewed in the browser.  
 
Layers are found in the Toolbox and dragged onto the design surface. Layers in Expression Web are 
created using div tags with CSS so you can place them anywhere on the page. This is called absolute 
positioning.  
 
Once you have inserted a layer into your page, you can insert any element, such as a graphic or text, 
into the layer. Layers are a popular choice among designers because they provide such precise 
layout control, but you should know that this is only one of many ways to create designs using CSS 
in Expression Web.  
 

1. You will notice a rectangle at the top of this new page—<form#form1>. Select it (it will turn 
blue) and press Backspace to remove it. You can easily select it by clicking on the outline of 
the rectangle or by clicking in it and then selecting <form#form1> from the Breadcrumbs 
trail at the top edge of the work area. Look back to page 6 to locate the Breadcrumb trail if 
you need to.  
 

 



 
2. To add a layer to a page, click to select the Layer icon in the Toolbox task pane and drag it 

onto the page. The layer will automatically appear in the top left of the page.  
 

 
 

3. To create the page layout for this design, click and a layer at the top of the page. You can 
resize a layer by clicking and dragging on any of its corners. You can also use the CSS 
Properties task pane usually found in the bottom left corner to specify the height and 
width.  

 
Note: If the CSS Properties Task Pane is not visible, select it from the list beneath the Task Panes 
menu at the top of the Expression Web Window.  
 
 
Power User Tip: If you are inserting an image and know its width, you can specify the layer size to 
match. If you do not know the image size, you can insert the image in a layer that is too small, and it 
will expand to accommodate the image. You can then check the actual image size by selecting it and 
noting the height and width in the Tag Properties task pane.  
 
 
 

4. To insert an image, click inside the layer to place the cursor within the layer (the layer 
should be transparent, not blue). From the Common Tool bar at the top of the work area, 
choose Insert | Picture | From File. Navigate to the Resource Files folder that came with 
this tutorial and choose the seals-top.jpg file. 



Note: If you attempt to move the layer but the image does not move, it is likely that the image was 
not inserted into the layer. Delete the image and repeat step 4.  
 

5. In the Accessibility Properties dialog, enter a description of the photo. For this example, 
enter "Creatures of the Water" and a long description, “Banner graphic with heading 
information.”  
 

6. Click OK. 
 

 
  
Why do you add text that describes our images?  
It makes our pages more accessible to users who might not be able to download the images or who 
are visually impaired. Some individuals, who are unable to see, have Web browsers read them the 
text on the page. These special browser features “tell” the user what the images show according to 
the alternate text.  
This text will display when the graphic is downloading, when it can't be found, or when a site visitor 
moves the cursor over the image.  
 
The alternate text entered into the Accessibility Properties dialog is inserted into the code behind 
the image and is a requirement for compliance with accessibility standards established by Web 
design organizations. For more about accessibility standards visit http://www.w3.org/WAI/  
 
 
Power User Tip: To open the Accessibility Properties dialog box in Design view, double-click the 
picture or single click the picture you want to set, and then on the Format menu, click Properties.  
  

http://www.w3.org/WAI/


 
 
Note the dimensions of the layer shown in the CSS Properties task pane shown above. Many values 
can be changed directly in this task pane.  
 
 
Power User Tip: The dimensions indicated on the CSS Properties pane must be followed by the 
letters ―px which stands for pixel. Note the top and left settings should both be 0 to position this 
layer in the upper left corner of the page.  
 
 
Let’s save your Web site project.  
 

1. Choose File | Save.  
 
Note: If you are saving this file for the first time Expression Web will offer to copy those files into 
your root site folder. Click yes or OK and they will automatically be copied into your folder.  
 
Take a peek at your project so far.  
 

2. Choose File | Preview in Browser | and select a browser from the pull out list. Expression 
Web will use an internal server to display your site exactly as it would appear if it were 
uploaded to a server on the Web.  
 

 

End of Module 1 
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Module 2 
 

Adding More Content  



 Module 2  
 
Adding More Content  
Note: To open your project again (if you had closed it after module 1) open Windows explorer and 
locate your storage folder. The project folder automatically created by Expression Web will likely 
look like this:  
 

 
 
Double click on that icon to open it. It might look similar to this:  
 

 
 
Double click on the index.aspx icon and your project will open in Expression Web.  



Now with your project open you are ready to start again.  
 

1. Add a second layer by clicking to select the layer icon in the Toolbox and dragging it onto 
the page. Then click and drag the layer to position it just below the first layer.  

 
 
Power User Tip: If you have a difficulties selecting a layer, click on it once and then select <div #layer 
2> from the Breadcrumbs trail at the top of the work area or from the Layers Task Pane. You will 
know it is selected when it is blue.  
 
 
 

 



 
2. Set the height, width and position in the CSS Properties task pane. This second layer should 

be set to Left 0, and Top 105 to appear immediately below the top layer aligned to the far 
left. Set the height and width to accommodate the image, which are 800 wide by 35 tall.  

 

 
 

3. Insert another image into the second layer. Insert the seals-nav.jpg image just as you 
inserted the top image by choosing Insert | Picture | From File and then selecting the file 
seals-nav.jpg from the Resource Files folder.  

 
4. Set the Alternate Text to Northern California Wildlife and the Long description to Banner 

graphic.  
 

5. Click OK.  
 

6. Choose File | Save.  



This is the result of inserting 2 images.  

 

 
 
Adding and Adjusting Layers  
Continuing with this page design, we'll now add three more layers, inserting content into each one, 
and then in a later step, we'll use the CSS Properties task pane to precisely position them so that 
the top of each layer lines up perfectly.  
 

1. Click to select the Layer icon in the Toolbox and drag in another layer. Use the image below 
as a guide to position the layer on the page. Don't worry about getting the layer in exactly 
the right place on the page or exactly the right size because we'll make those adjustments 
next.  

 
 

2. Open the word file named seals text.doc. You will find it in the Resource Files folder.  



 
3. Copy the top four lines of text, switch over to Expression Web, place your cursor in the new 

layer and paste the text.  
 
Alternatively, you can place your cursor into the new layer and enter the text by typing:  
Sea Otters  
Seals  
Water Fowl  
Frogs  
 
Power User Tip: You can use the key command combination of Alt + tab to switch between open 
programs.  
 
 
 

 



Adding More Content  
 

1. Click and drag in another new layer and position it in about the middle of the page, as you 
see in the image below.  

 
2. Click to place your cursor in the new layer <div#layer4> and choose Insert | Picture | From 

File and select the seals-bg.jpg from the Resource Files folder to insert it into the layer.  
 

3. Add appropriate Alt text and Long descriptions for this image. Alt text: Large image of 2 
seals Long description: Two seals resting on the beach  

 
4. Click OK.  

 
5. Resize the layer to better fit the image by changing the height and width in the CSS 

Properties task pane. The height is 398 pixels and the width is 300 pixels.  
 
 

 
 
 
  



Power User Tips: if you're not sure how big an image is, you can click to select the image, then open 
the Tag Properties task pane and check the height and width fields to determine the size of the 
image. (Expression Web automatically adds the height and width when it inserts an image.)  
 

6. Next click and drag in another new layer and position it at the far right side of the page, as 
you see in the image below. Remember that in order to move or resize the layer you must 
select it. Use the Breadcrumb trail or the Layers Task pane to select the layer. It will turn 
blue when selected.  

 
7. Again, open the Word file name seals.doc that came with your lesson files and this time 

copy all of the text below the top four lines.  
 

8. Switch back to Expression Web. (Alt + tab)  
 

9. Click to place your cursor in the new layer (it will be transparent – not blue- if the cursor is 
in the layer.  

 
10. But this time, choose Edit | Paste Text from the Common Toolbar at the top of the work 

area in order to open the ―paste text dialog.‖ This feature provides more options for how 
you include formatting when you paste text into Expression Web. Choose Normal 
paragraphs without line breaks. Click OK.  

 
11. Choose File | Save.  

 

 
 

  



Formatting Headline Styles  
 
Next, we'll add a headline to the story and format it with a header tag and then redefine the style of 
the header tag to change the font and size.  
 

1. Click to insert your cursor into the new layer on the right and use the arrow keys as 
necessary to get your cursor in exactly the top left corner of the layer.  

 
2. Press the return key to add some space at the top of the text.  

 
3. Use the arrow keys to return to the top left, and enter "Harbor Seals Lounge on California's 

Beaches."  
 

4. Click and drag to select the headline you just added: Harbor Seals Lounge on California's 
Beaches.  

 
5. From the Common toolbar (top of work area) choose Heading 1 <H1> and the text will 

automatically resize and become bold.  
 

 
 
 
 
  



Heading styles offer many advantages, but if you don't like the way they appear, you can change 
the style by creating a new CSS Style. You can also create external style sheets with Expression Web. 
Explore the Help menu to learn more about this advanced feature.  
 

6. Click on the New Style link in the Apply Styles or Manage Styles task panes (bottom right of 
work area).  

 
7. In the New Style dialog, choose a selector. If you click on the arrow next to the Selector 

field, you can choose any HTML tag to redefine its appearance. Choose h1. Leave the Define 
in option set to Current Page.  

 
8. With the Font Category open, set the Font-Family to Arial, Helvetica, sans-serif.  

 
9. In the Font-size field enter 16 and make sure the size is set to px for pixels. (Note: you can 

also choose from many options when specifying font size in Expression Web.)  
 

10. When you click OK the new style is automatically applied and the headline you formatted 
with the h1 tag automatically changes to reflect the new style.  

 
11. Choose File | Save.  

 

  



Positioning Layers with the CSS Properties task pane  
Even after you add content to layers, you can still use click and drag to resize and move them 
around. If you want to be even more precise, you can use the CSS Properties task pane and enter in 
the exact height and width, as well as the position you want for each layer. 
  
First you'll need to select each layer one at a time, and here's a tip. If you're having trouble selecting 
the layer instead of the contents within the layer, you can use the Breadcrumb trail at the top of 
the work window to insure you've selected the layer. A layer will appear blue when selected.  
 
As you see in the image below, I've used the Breadcrumb trail to select the middle layer, which is 
especially tricky because when you have an image in a layer it's easy to select an image by mistake 
when you want to select a layer.  
 

 
 
  



Here's how you can use the CSS Properties task pane to align images.  
To adjust all three layers so that they line up with each other at the top just below the banner 
graphics, you'll want to set the top position so that it's the same for all three. In this case, they 
should all end up 180 pixels from the top of the page, meaning the top of the layer will be exactly 
180 pixels from the top of the browser window.  
 

1. Select a layer and then click the CSS Properties task pane tab.  
 

2. To position the layer, change the top field, under the Position category of properties, by 
entering exactly 180 pixels.  

 

 
 

3. Next, select the middle layer (the one with the photo of the two seals) and change the top 
field to 180 pixels.  

 
4. And finally, select the third layer (the one with the story and headline) and change the top 

field to 180 pixels. This should align all three layers.  
 

5. Choose File | Save.  
 

Nesting layers 
 If your layers aren’t lining up properly, one possible reason is that you’ve created layers nested 
inside other layers. As you become more adept with layers, you can use nesting to group layers, but 
when layers are nested, their position is affected by the layer they are connected to.  



You can nest and un-nest layers in the Layers task pane if you need to.  
 

 Open it, by choosing Task Panes | Layers.  
 

 In the Layers task pane, you can click and drag layers to change their order.  
 
As you can see in the image below, layer 2 is nested within layer 1. Dragging layer 2 above layer 1 
will un-nest the layer, dragging a layer onto another layer will nest it within the first layer. If you’ve 
ever moved files in and out of folders on your desktop, the process should feel familiar.  
 

 
 

Using CSS to Align Images  
Next, we'll add a small image to the layer with the story and headline and create a style to align that 
image so the text wraps around it.  
 
1. First, click to place your cursor at the beginning of the first paragraph in the story, just before the 
words "Just off California Highway 1…"  
 
2. Choose Insert | Picture | From File.  
 
3. Select the image called seals-small.jpg from the Resource Files folder and click OK.  
 
4. In the Accessibility Properties dialog, enter the Alt text for the photo. For this example, enter 
"Photo of Harbor Seals on the beach." Long description: Large group of seals on a California beach. 
Click OK.  
 
Note: When you add an image to a Web page next to text, the image is automatically placed on its 
own line and the text will begin at the very bottom of the image and continue below it as you see in 
the previous Figure.  



If you want your images to be aligned to the left or right of the page and your text to wrap about 
them, you'll need to change the alignment of the image, and the best way to do that is to create a 
style. For this purpose, we'll create a class style that can be applied to any element on the page.  
 

1. Choose New Style from the Apply Styles task pane.  
 
 

2. In New Style dialog, enter (type) .img-right in the Selector field.  
Note: All class styles must begin with a dot or period.  

 
3. In the Layout Category of the New Style dialog, set the Float to right.  

Do not click OK yet.  
 

 
 
  



4. Select the Box Category.  
 

5. Uncheck the Same for all box above Margin.  
 

6. Enter 10 px in the left field and 10 px in the bottom field.  
 

7. Click OK to create the new style.  
 
Note: This will create a little breathing room around your image so that the text does not bump 
right up against the picture. Since we are aligning this image to the right, we're adding add a little 
margin space to the left and bottom of the image. Notice the CSS Box model reference in the 
middle of this Figure to help you appreciate the difference between Margins and Padding. You may 
also want to create a style called img-left, with the float set to left and the margins set to 10 px on 
the right and bottom.  
 

 
 
  



Now that you've created a style to align your image, applying the style is the easy part.  
 

1. Click to select the small image of the seals that you inserted into the layer with the story 
and headline.  

 
2. In the Apply Styles task pane, click to select the .img-right style.  

 
The image should immediately align to the right and the text should wrap around to the left with 10 
pixels of margin on the left and bottom of the image.  
 

 
 
Power User Tip: It can be challenging to place your cursor next to an image in a layer. But the easy 
solution is to first click anywhere on the image to select it and then use the right arrow key on your 
keyboard to move your cursor off the image yet keep it in the layer. Then press the enter key to add 
a space and you're ready to add your text below the image.  
 
 

3. Save your files. Click OK to save the images also.  
 
 

End of Module 2  
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 Module 3  
 

Creating More Pages and Links 

Whether you want to create links to pages in your own site or to another Web site on the Internet, 
creating links with Expression Web is an easy process. However, before we can link to another page 
in our new site, we should probably create one. Here’s a quick review of creating a page to get you 
ready to create your first links.  
 

1. Open your project Web site if it is not already open.  
 

2. Choose File | New | ASPX and a new blank page appears in the central work area.  
 

3. Open the Page Properties dialog by right clicking anywhere within the body or workspace 
of the page. Changes made in this dialog will apply to the entire page. It’s a good habit to set 
all of the Page Properties settings as soon as possible.  

 
4. Add a page Title—Sea Otters. Add a Page description and a few Keywords that can be used 

by search engines. Change the link colors on the Format tab as you did for the first page. Set 
the margins to 0.  

 
5. Select the <form#form1> at the top of the page (it will turn blue). Press Backspace to 

remove it.  
 

6. Choose File | Save |  
 

7. Name this page sea_otters.aspx, be sure the location is the folder you saved the first page 
in and click Save.  

 
Note: Since this is not the main page of the site, we can name it anything we want as long as you 
avoid spaces and special characters that can cause problems on a Web server.  



Adding content to the page  
For now, we’ll just add some text to this page so we have something here to identify it.  
 

1. Add a layer to the top of this new page. Place your cursor in the top of the work area, enter 
“Sea Otters,” and format it with an H1 tag. Adjust the size and shape of the layer to fit the 
text.  

 

 
 

2. Choose File | Save to save this page and we’re ready to create a link to it from the page 
we’ve been building.  

 
Your task in the next module will be to gather images and information for this page and for 2 more 
pages: Water Fowl and Frogs  



Creating Links  
 

1. To switch back to the page you designed in the first part of this lesson just click on the 
index.htm tab at the top of the work space. Notice that any time you have more than one 
page open in Expression Web you can switch between pages by selecting the corresponding 
tab at the top of the page. You can open pages by double-clicking on it in the Folder List at 
the left of the workspace.  
 

 
 
Now we’re ready to create that link to the other page in your site.  
 

2. Click and drag to select the Sea Otters text in the small layer in the left side of this design.  
 

3. Choose Insert Hyperlink  
 

3. Select the seaotters.aspx page we just created.  
 

4. Click OK and the link is automatically set.  
 

 



Now let’s create a link to another Web site and then preview the page in a browser to test both 
links.  
 

1. Click to place your cursor in the middle layer, just under the photo of the seals. Refer to 
the Power User Tip below if you are having difficulties. Then press the enter key to add a 
space and you're ready to add your text below the image.  

 
 
Power User Tip: It can be challenging to place your cursor next to an image in a layer. But the easy 
solution is to first click anywhere on the image to select it and then use the right arrow key on your 
keyboard to move your cursor off the image yet keep it in the layer.  
 

2. Enter the words "California Nature Conservancy." Click and drag to select this text.  
 

3. Choose InsertHyperlink  
 

4. To create a link to another site, enter the full URL of the site in the Address field. For 
this example, enter http://www.nature.org/  

 
5. Click OK and the link is automatically set.  

  



To test your links, you have to preview your page in a browser.  
 

1. First, save your page by choosing File | Save.  
Note: If you are saving this file for the first time and you have used the images provided, Expression 
Web will offer to copy those files into your root site folder. Click yes and they will automatically be 
copied into your folder.  
 

2. Then choose File | Preview in Browser | and select a browser from the pull out list.  
 
Power User Tip: You can preview your pages with Expression Web using any browser available on 
your computer. Testing your pages in different browsers is an important part of ensuring your pages 
will work for the broadest audience on the Internet.  
 
 

 
 

 
Power User Tip: If the links to other pages in your site do not work, it may be that you must enter 
the COMPLETE path from your computer to the network location where your pages are saved. You 
teacher can help you identify this long path name.  
 
 
Power User Tip: In a “real world” scenario, displaying a Web site for real visitors would require 
uploading your site to a server. For a classroom scenario, it can all be accomplished with 
Development Server…which is a part of Expression Web. This internal server takes the place of the 
server that would later host your site so that you can test your site before you actually put it on the 
Web.   



With your page previewed in a program like Internet Explorer, shown below, you can click on your 
link and open the page you created with the headline Sea Otters. 
 
When you preview pages on your hard drive, you can follow links through your site just as they will 
work when the site is transferred to your Web server. Links to other Web sites will work if you are 
connected to the Internet.  
 

 
 

 
 
 
 

End of Module 3 
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Module 4  
 

Expanding your Web site 

Now that you have created 2 pages in Expression Web, it’s time to practice your skills!  
 
Important Reminder: As you develop these additional pages, be sure to periodically save your 
work. A good habit is to save every 5 to 10 minutes. You can tell which files are not saved by the * 
next to the file name on the page tabs just above the Expression Web workspace.  
 

 
 

1. Add 2 more pages to the Web site: Water Fowl and Frogs.  
 

2. Create links from the first page to each of these pages.  
 

3. Search the internet for an image appropriate for each of these 3 pages: Sea Otters, Water 
Fowl and Frogs. Remember that this site is about Northern California Water Creatures. Be 
sure to consider that in your searching. Save the images you select in the Resource Files 
folder.  

 
4. Learn something new about the creatures you select. Write a short paragraph about each 

animal.  
 

5. Create an attractive layout for each page with a layer to contain each image and a layer for 
text content.  

 
6. Create a link on each of the last 3 pages to navigate back to the first page.  

 
7. Choose File | Save.  

 
8. Preview your site in the browser.  

 

End of Module 4 
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 Module 5 

 
Creating Interactive Buttons  
Now that you know how to create links, let’s rework the main navigation to make it a bit to make it 
more interesting. You have probably seen interactive buttons on other websites. They are buttons 
that change as you move your mouse over them and as you click on them. In the past, you had to 
write a lot of HTML and javascript to add an interactive button to a page, but Expression Web 
makes it easy.  
 

1. Switch to the index.aspx page by clicking on the appropriate tab or use the Folder List.  
 

2. Highlight the four navigation links on the left side of this page and press Backspace on your 
keyboard. Make sure you don’t delete the Layer that the links were in. Your cursor should 
be on the top-left side of this layer. Select Undo if you deleted too much.  

 
3. Choose Insert | Interactive Button  

 
4. Select the button style that you want to use. Notice the preview button will change to 

display the highlighted style. For this example, select Metal Rectangle 1.  
 

5. In the Text field enter―Harbor Seals. This will be the text that appears on the button.  
 

6. Click the Browse button next to the Link field.  
 

7. Select the page that the button will link to. For this example, select the index.aspx page 
because that is the page with the content about Harbor Seals.  
 

8. Click OK and the page will automatically be filled in the Link field.  
Do not click OK yet.  

  



 
 

9. Under the Font tab in this same dialog, you can specify text, link colors, and alignment for 
your button.  

 
For this exercise change the text as follows:  
Font | Arial, Helvetica, sans-serif  
Font Style | Bold, Size | 14  
Original Font Color | Maroon  
Hovered Font Color | Silver  
Pressed Font Color | Yellow.  
 
Leave the horizontal and vertical alignments set to center.  
 
Experiment with different styles, font, and colors if you’d like to.  



 
10. Under the Image tab you can specify size, settings, and background for your image. For this 

exercise, change the Width to ―135 and leave the other settings as is. Make sure the 
Maintains proportions box is checked.  

 
11. Choose File | Save.  

 

 
 

12.  Create buttons for each of the remaining words in the menu—Sea Otters, Water Fowl, and 
Frogs using these same steps.  

 
13. Click OK now and the button will be automatically created.  

  



 
 
It’s time to preview your site in a browser.  
 

1. Save your page by choosing File | Save.  
 

2. Because the interactive buttons you just created are images, a dialogue box will appear and 
ask you if you want to save the newly created image files. Click OK.  

 
3. Then choose File | Preview in Browser and select a browser from the pull out list.  

 
4. If you need to change any aspects of an interactive button, right click on the button and 

select Button Properties.  



 

 
 
5. Choose File | Preview in Browser | and select a browser from the pull-out list.  
 
With your page previewed in a Web browser, your buttons will change when you put your mouse 
over them and when they are being clicked. Notice that the whole button changes, not just the text.  
 
When you click the button you will be taken to the appropriate page.  
You might want to replace the link you created on each page to get back to the first page with an 
interactive button.  
 
There are many other ways to create Web designs with this program, including other CSS design 
options, tables, frames, templates, and more dynamic development features for ASP.NET sites. You 
may want to experiment with these other options. There are many online resources to help you 
learn more about the features described in this tutorial and other cool features.  
 
 

End of Module 5 
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 Module 6  
Extra Fun with a Calendar  
 
Half of the fun of learning any new software is to experiment with some of the features you did not 
have the opportunity to learn during the exercises. A simple and fun control to add to any Webpage 
is a calendar.  
 
Create a new layer on the index page. Carefully move it to the bottom of the page. Remember to 
use the Layers task panel to select the layer in order to more easily move it. If you accidentally 
move other layers in the process, remember ―Undo‖ will put things back.  
 

1. Set the dimensions of this new frame to width = 203 and height = 142. This is the standard 
calendar size. You can make the calendar larger by stretching it if you want.  

 
2. Click in the new layer to position the insert cursor in that location.  

 
3. Look in the Toolbox under ASP.NET Controls | Standard to locate the Calendar control.  

 
4. Drag the Calendar into the new layer.  

 
5. Click on the small > that is hanging off the top right corner of the calendar.  

 
6. Select AutoFormat to choose an appealing design.  

 
7. Choose File | Save and preview in the browser to use your new interactive calendar.  

 
 

Congratulations! Your project is now complete.  
 

You’ve just completed the “My Beach Trip” Web site using Expression Web.  You learned to use 

many tools and Web technologies that will be useful as you design more Web pages.  
 

Where do you go from here?  

There are many other ways to create Web designs with this program, including other CSS design 

options, tables, templates, and more dynamic development features for ASP.NET sites. You may 

want to experiment with these other options. There are many online resources to help you learn 

more about the features described in this tutorial and other cool features.  

 

Learn about more fun controls by exploring the Help menu or other tutorials in the Learn Expression 

Web Center  

http://expression.microsoft.com/en-us/cc197140.aspx  

http://expression.microsoft.com/en-us/cc197140.aspx


Wrap-Up  
Let’s review what you have learned.  
 

1. ASP.NET is a Microsoft technology for creating dynamic and interactive Web sites.  
 

2. Microsoft’s Expression Web environment offers ―Drag and Drop‖ Web design through the 
use of tools found in a variety of toolbars, toolboxes, and panes.  

 
3. Creating a new site creates a folder that holds all of the files related to your site.  

 
4. Layers are used to position page elements such as images or text and can be positioned to 

allow for creative designs.  
 

5. Images should have alternate text to meet accessibility standards.  
 

6. The Tag Properties and CSS Properties panes provide information about page elements and 
allow for precise manipulation of elements.  

 
7. Standard formatting tags such as headings, fonts, and font size are selected from the 

Common Toolbar.  
 

8. The standard tags can be modified or new styles created by selecting New Style in the Apply 
Styles or Manage Styles task pane.  

 
9. Web pages can be viewed as they will appear in various browsers by selecting File | Preview 

in Browser. The pages are rendered through the internal Development Server.  
 

10. Links to other pages or to other Web sites on the Internet can be attached to text or images.  
 

11. Interactive buttons add functionality and interactivity to your Web pages. Microsoft 
Expression Web makes it easy for you to add buttons to your Web pages that resemble 
buttons you would expect from an advanced graphics-editing tool.  

 
12. The calendar is an ASP.NET control and demonstrates a dynamic feature.  



A Glossary for Microsoft® Expression® Web  
 
Accessibility  
Standards have been established for Web sites to ensure that everyone has access to Web content. 
These standards include alternate tags for visual elements (such as images) that describe them for 
users who use browsers that are unable to view images, or users who are visually handicapped. See 
http://www.w3.org/WAI/ for more accessibility standards.  
 
ASP.NET  
The latest version of Microsoft's Active Server Pages technology (ASP) is a powerful tool for creating 
dynamic and interactive Web pages.  
 
Bread Crumb Trail  
A navigation tool found at the top of the workspace window enables the user to select the layer or 
element recently used within the Web site files.  
 
Common Toolbar  
Frequently used options and actions are located at the top of the workspace and include a variety 
of choices under File, Edit, View, Insert, Format, Tools, Table Site, Data View, Task Panes, Window, 
and Help.  
 
CSS (Cascading Style Sheets)  
Cascading Style Sheets contain details for modifying standard formatting tags, such as Heading 1, or 
for entirely new styles named and defined by the designer. These details can be saved in a .css file 
and attached to Web pages. The details over-ride standard formatting tag specifications. See 
External Style Sheet.  
 
Folder List  
A pane within the workspace that shows all of the files within the folder created to hold the Web 
site files. It is usually located at the top left of the workspace.  
 
External Style Sheet  
Formatting details saved in a .css file and attached to Web pages. The details over-ride standard 
formatting tag specifications.  
 
HTML (HyperText Markup Language)  
HyperText Markup Language is the basic code used to create Web pages. It uses tags in the form of 
<some tag> to instruct a browser how to display content.  
 
Layer  
A layer is a container that holds an element on your Web site but is invisible when the page is 
viewed in the browser. Layers are found in the Toolbox and dragged on to the design surface.  
 
RSS  



A Web feed format used to gather updated Web content such as blog entries, news headlines, or 
podcasts. An RSS ―feed‖ contains content from an associated Web site. RSS makes it easy to keep 
up the frequently changing Web sites.  
 
Style Sheet  
See Cascading Style Sheet (CSS)  
 
Tag  
The basic HTML code structure that defines the formatting required for the content of a Web page 
for a browser.  
 
Task Panes  
The workspace of Expression Web is organized into areas called task panes. Each task pane provides 
the choices for actions to take on various elements in the Web site project. The panes include the 
Folder List, CSS Properties, Tag Properties, the Toolbox, Layers, Managing and Applying Styles, plus 
others required for specialized work.  
 
Toolbox  
This task pane contains the drag-and-drop elements that can be added to a Web page. The tools are 
divided into specialized groups including Tags, Form Controls, ASP.NET Controls, and others. 
  
View Tabs  
View Tabs located at the bottom of the workspace enable the designer to select to view a Web 
page by its design, code, or in a split window showing both design and code.  
 
XML  
XML is a general-purpose markup language that allows users to define their own tags. It is primarily 
used to share data between different information systems via the Internet. It allows unlike 
computers to communicate. 

 


